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Resumen 

El canal iónico Transient Receptor Potential Melastatin 8 (TRPM8) es un termocanal sensible a las 

bajas temperaturas, que se encuentra principalmente en neuronas sensoriales primarias de los ganglios 

trigéminos y dorsales. Se ha visto involucrado en hipersensibilidad al frio en contexto de dolor crónico al dañar 

los nervios periféricos o por el uso de fármacos quimioterapeúticos para tratar algunos tipos de cáncer. El 

objetivo principal de este trabajo es la búsqueda de antagonistas no competitivos del canal que podrían aliviar 

los síntomas de la neuropatía periférica. Para este fin se construyó un modelo del canal TRPM8 a partir del de 

otro miembro de la familia TRP, TRPV1 cuya estructura ha sido estudiada por crio-electromicroscopía de 

partícula única. El nuevo modelo de TRPM8 construido por homología se utilizó para realizar cribado virtual 

computacional enfocado hacia la búsqueda de sitios de unión para los ligandos, entre sitios ya conocidos como 

el del mentol o la icilina, además de los giros extracelulares. Los resultados obtenidos indican que un grupo de 

ligandos que comparten similitudes estructurales tiende a unirse a residuos del sitio de mentol, mientras que 

otro, a los giros extracelulares y al sitio de la icilina. Dicha preferencia podría explicarse por la diferente 

estructura química de los distintos ligandos y el entorno químico de los sitios de unión. A pesar de ello se 

necesitará un estudio posterior que profundice más en el comportamiento del canal tras la interacción con el 

efector. 

The ionic channel Transient Receptor Potential Melastatin 8 (TRPM8) is a termochannel sensible to 

low temperatures that is primarily localized on primary sensory neurons of the trigeminal and dorsal ganglia. It 

has been seen to be involved in hypersensitivity to cold in a chronic pain context during the harm of peripheral 

nerves or by the usage of chemotherapeutic drugs for the treatment of different types of cancer. The principal 

objective of this work is the search of non-competitive antagonists of the channel which might ease the 

symptoms of the peripheral neuropathy. In order to achieve it, a model of the TRPM8 channel was built from 

the model of another member of the TRP family, TRPV1, whose structure was studied by single-particle cryo-

electromicroscopy (cryo-EM). The new model of TRPM8 built by homology was used to perform a 

computational virtual screening focused on the search of binding sites for the ligands, from sites already 

known, as the one of menthol, icilin or the extracellular loops. The obtained results indicate that a group of 

ligands that have structural similarities join to the menthol binding site, while others, to the extracellular loops 

or the icilin binding site. This preference can be explained due to the chemical structure of the different ligands 

and the chemical environment of the binding sites. Nevertheless, a more profound study is needed, which 

should center on the behavior of the channel after the interaction with the effector. 

 
 
Palabras clave: TRPM8, neuropatía periférica, hipersensibilidad, cribado virtual computacional, antagonista. 
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1. Introducción 

1.1. La familia de canales TRP 

1.1.1 Generalidades 

Los canales TRP (Transient Receptor Potential) son canales iónicos no selectivos a cationes que median 

el flujo de Ca
2+

 y Na
+
 a través de la membrana celular. En las células excitables, la apertura de los canales TRP 

causa una despolarización en la membrana lo que facilita la generación de potenciales de acción. Por otra 

parte, en células no excitables causan la entrada masiva de Ca
2+

 que actúa como mensajero, activando distintas 

rutas de señalización intracelulares. Debido a la gran diversidad de mecanismos de apertura que presenta, esta 

familia de canales tiene un papel importante en la fisiología sensorial, incluyendo el gusto, visión, olfato, oído, 

tacto, nocicepción, osmo y termocepción.  

Los canales TRP comparten homología de secuencia, lo que sirve para clasificarlos. Existen 7 

subfamilias de canales TRP. Entre ellas están TRPA (Ankyrin) cuyo nombre se debe a las numerosas repeticiones 

de anquirina en el extremo N-terminal del canal, TRPP (Polycystin), también conocida como proteína de la 

enfermedad de los riñones poliquísticos. TRPML (Mucolipin) se relaciona con la mucolipidosis tipo IV, 

enfermedad neurodegenerativa relacionada con el almacenamiento lisosomal. TRPN (No-mechano-potential C 

channel) está ausente en mamíferos y sólo aparece en un vertebrado, el pez cebra. TRPC (Canonical) fue el 

primer canal TRP encontrado en mamíferos. TRPV (Vanilloid) cuyo primer ligando encontrado fue la capsaicina, 

un compuesto vanilloide y finalmente, TRPM (Melastatin) que recibe el nombre del primer miembro 

encontrado de esta subfamilia, llamado melastatina.  

En cuanto a la estructura de los canales TRP, estos presentan 6 segmentos transmembrana (S1-S6) con 

largas terminales N y C, intracelulares. La mayoría forman homotetrámeros que dan lugar a poros permeables 

a cationes. La activación de los canales TRP puede estar modulada por voltaje, ligandos, temperatura o 

estímulos mecánicos, aunque existen algunos que están constitutivamente activos. Además, existen canales 

TRP polimodales lo que significa que pueden ser activados por varios estímulos diferentes.  

Las enfermedades relacionadas con los canales TRP son de dos tipos. Las canalopatías causadas por un 

malfuncionamiento del canal y las enfermedades en las que están involucrados dichos canales al ser la diana 

natural de toxinas o productos irritantes e inflamatorios. La desregulación de los canales TRP, tal como su 

desensibilización o cambios en el número de canales expresados, puede conllevar a estados patológicos. Las 

enfermedades causadas por una disfunción o desregulación hacen de los canales TRP dianas prometedoras 

para una modulación farmacológica.  

1.1.2. Canales termoTRPs y termotransducción 

Los canales iónicos termosensibles, presentes en las terminaciones nerviosas de las neuronas 

sensoriales periféricas que inervan la piel y las mucosas, son cruciales para la percepción de la temperatura. Los 

canales TRP sensibles a la temperatura tienen una gran dependencia hacia ésta y por eso reciben el nombre de 

termoTRPs. Entre estos canales se encuentran aquellos activados por el calor como algunos de la subfamilia 
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TRPV y TRPM, y otros activados por el frío, entre ellos TRPA1, TRPC5 y TRPM8. Entre todos, presentan un 

umbral de activación que va desde el frío más insoportable hasta el calor quemante.  

Son las fibras periféricas aferentes de las neuronas sensoriales las que detectan los estímulos 

sensoriales por todo el cuerpo, y se encargan de transmitir la información recibida hasta el sistema nervioso 

central. Las aferentes sensoriales periféricas de los ganglios trigéminos inervan todos los tejidos de la cabeza y 

tienen la misma función. Las fibras aferentes periféricas forman tres grupos distintos basados en la velocidad 

de conducción de los estímulos. Las fibras Aβ con gruesas capas de mielina tienen una velocidad de conducción 

alta. Las fibras tipo I y II Aδ con capas finas de mielina tienen una velocidad inferior. Finalmente, las fibras C sin 

mielina son las que presentan la velocidad más baja de conducción de los estímulos. La termocepción en 

mamíferos está mediada por las fibras Aδ y C. Las C conducen los estímulos procedentes del calor moderado y 

el frío doloroso, mientras que las Aδ, el frío moderado. Las Aδ tipo I transmiten estímulos de calor doloroso.  

1.1.3. Subfamilia de canales TRPM 

La estructura de los canales TRPM se diferencia de algunas de las demás subfamilias TRP por el hecho 

de presentar en el extremo C-terminal una región altamente conservada de 23-25 aminoácidos que recibe el 

nombre de dominio TRP. Además, en el extremo N-terminal no presentan repeticiones múltiples de anquirina a 

diferencia de otras subfamilias.  

Algunos miembros de la familia TRPM como TRPM4 y TRPM5 se caracterizan por ser impermeables al 

Ca
2+

, permeando sólo cationes monovalentes. Ambos miembros y además TRPM2 y TRPM3 se expresan en 

células beta pancreáticas productoras de insulina. La reducción de su expresión reduce la secreción de insulina 

inducida por glucosa. TRPM5 además participa en la transducción de las señales producidas por el sabor dulce, 

amargo y umami.  

Finalmente, TRPM8 es un sensor de temperaturas en un rango de frescor cómodo hasta frío doloroso. 

Éste es el canal en el que se centra el presente trabajo y se desarrollará más ampliamente a continuación.  

1.1.4. El canal TRPM8 

En 1951 fueron descubiertas evidencias sobre un receptor de frío y mentol presente en neuronas, 

pero no fue hasta el 2001 cuando se clonó un gen que presentaba altos niveles de homología con proteínas 

TRP y a la proteína resultante de 1104 aminoácidos se le dio el nombre de TRPP8. Más tarde, en el 2002, se 

renombró como TRPM8.  

Como otros miembros de la superfamilia TRP, TRPM8 está constituido por 4 subunidades, cada una de 

las cuales comprende 6 dominios transmembrana con un poro iónico entre S5 y S6. El C-terminal con 120 

residuos es más corto comparado con otros miembros de la familia TRPM. Contiene dominios coiled-coil 

conservados que se piensa están involucrados en la tetramerización del canal. El C-terminal fue determinado 

como una parte esencial para el correcto funcionamiento del canal. En el C-terminal también está ubicado el 

dominio TRP, altamente conservado, que es responsable de los cambios conformacionales en el canal cuando 

se le une algún ligando. El dominio TRP además contiene sitios de unión para fosfolípidos de membrana, 

requeridos para la activación del canal.  
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El TRPM8 es un canal dependiente de voltaje, sin embargo, todavía no se conoce bien del todo la 

posición exacta del sensor de voltaje. Algunos autores sugieren que depende de la interacción entre S4 y S5, 

mientras que otros, entre S3 y S4.  

El mecanismo de dependencia a la temperatura está regulado por el extremo C-terminal ya que fue 

observado que un cambio entre dichas regiones de los canales TRPM8 y TRPV1, cambia la dependencia a la 

temperatura en TRPM8, haciéndolo sensible al calor.  

El dominio N-terminal contiene unos 700 aminoácidos y 4 regiones TRPM homólogas (MHR), 

presentes en todos los miembros de la subfamilia TRPM. La principal función del N-terminal es la correcta 

localización del canal en la membrana plasmática. Además algunos de sus residuos son fosforilados por la 

proteína quinasa A, regulando la actividad del canal. Los residuos de cisteína 929 y 940 forman un puente 

disulfuro y también son esenciales para la actividad del canal. Dicho puente flanquea el sitio de glicosilación del 

canal, encontrándose en el residuo Asn 934.  

En general, la actividad de la mayoría de proteínas (enzimas, canales iónicos) aumenta con la 

temperatura, sin embargo en el caso de TRPM8 esto no sucede, activándose éste a temperaturas bajas. Para 

explicar este suceso se propuso un modelo de dos estados en los que el grado de cierre es más dependiente de 

la temperatura que el grado de apertura del canal. De esta forma, a temperaturas bajas, el grado de apertura 

permanece constante mientras que el de cierre disminuye, provocando la activación del canal. Además, la 

transición del estado cerrado al estado abierto es dependiente de voltaje, activándose el canal a potenciales 

más positivos. Este modelo es válido para temperaturas de 10°C a 45°C, que se pueden dar en condiciones 

fisiológicas. Sin embargo, este modelo no explica algunos resultados experimentales, y debido a ellos se 

propuso otro, un modelo alostérico. Según éste, los distintos dominios de la proteína actúan como sensores de 

voltaje, temperatura y agonistas, y modulan la apertura y cierre del canal. Este modelo es más complicado y 

tiene en cuenta mayor cantidad de variables.  

El canal TRPM8 se encuentra principalmente en las neuronas sensoriales primarias, en concreto, una 

población de neuronas sensibles al frío, de pequeño y mediano diámetro en los ganglios trigéminos y dorsales. 

Las terminaciones periféricas de estas neuronas inervan la piel, lengua, paladar, dientes, córnea, colon y vejiga. 

TRPM8 se expresa en fibras C sin mielina y en fibras Aδ recubiertas de finas capas de mielina. También se ha 

visto expresado en tejido broncopulmonar y tejido no nervioso, en la próstata, testículos, tracto urogenital, 

hígado, pulmones, la capa muscular vascular, espermatozoides y adipocitos blancos. Finalmente, TRPM8 fue 

encontrado en células tumorales neuroendocrinas y del melanoma. 

En cuanto a la farmacología de TRPM8, éste se ha visto activado por distintos agonistas naturales 

como el mentol y el eucaliptol, alcoholes cíclicos monoterpenoides, y compuestos sintéticos como la icilina, 

geraniol, hidroxicitronelal, linalool y derivados sintéticos del mentol utilizados en la industria cosmética. Entre 

los antagonistas del canal se encuentran el BCTC o el bloqueador no específico de canales permeables al calcio, 

SKF96365, clotrimazol y econazol. Los agonistas provocan un desplazamiento en la dependencia al voltaje hacia 

potenciales más negativos, facilitando la apertura del canal en condiciones fisiológicas, mientras que los 

antagonistas, causan un desplazamiento hacia potenciales más positivos. En cuanto a los sitios de unión de los 

ligandos mencionados anteriormente cabe destacar que el residuo Tyr745 (S2) tiene un papel crucial para la 
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unión del mentol. Recientemente también se ha comprobado que los residuos cargados positivamente Arg842 

y Lys856, que se encuentran en S4 y el bucle entre S4-S5, están implicados también en dicha unión y activación 

del canal (Voets et al., 2007). La principal interacción que estabiliza la unión entre el mentol y el residuo Tyr745 

es un puente de hidrógeno formado con el grupo hidroxi del ligando. Por otra parte, varios residuos apolares 

(Val742, Val743, Phe744, Ile746, Ala747, Phe748, Leu749, Leu750 en S2 y Leu806 en S3), están involucrados en 

contactos hidrofóbicos con el esqueleto de la molécula del mentol. La iclina por su parte, interacciona con los 

residuos Asn799, Glu802 y Gly805 (S3) aunque también con Tyr745.  

El pH intracelular modula la actividad de TRPM8. Un aumento del pH intracelular acentúa la activación 

por frío e icilina, mientras que una disminución en el pH dificulta este hecho. Por otra parte, la activación 

inducida por mentol es independiente del pH en un rango de 6.5 hasta 8. 

La N-glicosilación del residuo Asn934 facilita la segregación de TRPM8 en balsas lipídicas ricas en 

colesterol. La disminución de los niveles de colesterol estimula la activación del canal inducida por mentol y 

frío.  

1.1.5. Papel fisiológico de TRPM8; analgesia y cáncer 

Una de las principales funciones fisiológicas que recibe el canal TRPM8 es actuar como un sensor de 

frío. Indiscutiblemente el canal es un transductor del frío indoloro, sin embargo, cuando se quiso comprobar su 

función en la transducción del frío extremo y doloroso, los resultados no fueron tajantes. Algunos grupos 

obtuvieron resultados que indicaban este hecho mientras otros no. Finalmente se llego a la conclusión de que 

el canal transmite los estímulos por frío extremo aunque existen otros canales iónicos que tienen la misma 

función y contribuyen a la sensibilidad hacia este rango de temperaturas. Algunos ejemplos de dichos canales 

son el TRPA1 y algunos canales de potasio.  

En ratas y ratones se ha observado un papel termorregulador y de termo génesis del canal, para 

controlar y mantener la temperatura corporal. La activación del canal por agonistas como el mentol, el 

eucaliptol o la icilina, produce un aumento en la temperatura corporal, hecho que no se ha observado en 

animales TRPM8 knock-out. Por otra parte, los antagonistas del canal producen un descenso en la temperatura 

corporal en animales silvestres.  

Otras funciones fisiológicas son la vasoconstricción y vasodilatación cuando el canal se expresa en el 

tejido muscular vascular. Además su presencia en el tracto urogenital, en los testículos o en el esperma sugiere 

un papel en la fertilidad masculina. En los pulmones TRPM8 puede causar una constricción de las vías 

respiratorias al inhalar aire frío. Por último, en la córnea controla el flujo lagrimal basal. 

TRPM8 también está involucrado en la hipersensibilidad al frío en el contexto del dolor crónico 

causado por algún daño físico. Daño en los nervios periféricos puede causar dolor neuropático periférico, 

caracterizado por un incremento en la intensidad del dolor hacia estímulos ligeramente dolorosos 

(hiperalgesia) o estímulos indoloros (alodinia). En pacientes con trastornos en los nervios periféricos, el frío 

inocuo provoca sensaciones dolorosas. Un agente quimioterapéutico utilizado para tratar el cáncer colorectal, 

llamado oxaliplatino, causa hipersensibilidad hacia el frío lo que restringe las dosis y duración de los 

tratamientos. En ratones, una inyección de oxaliplatino o un daño constrictor crónico en el nervio ciático, 
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producen hipersensibilidad hacía el frío. Se ha observado que en ratones TRPM8 knock-out o tratados con 

capsazepina, un bloqueador inespecífico de TRPM8, o PBMC, antagonista de TRPM8, atenúan dicha 

hipersensibilidad.  

Por otra parte, TRPM8 es el mediador principal de la hipersensibilidad hacia el frio inducida por 

inflamación. Esto se debe posiblemente a que TRPM8 es modulado por mediadores inflamatorios como 

fosfolípidos, protones y bradiquinina.  

A pesar de todo ello, aplicaciones tópicas de mentol y ligeros enfriamientos focalizados se han 

utilizado para mejorar el dolor crónico de espalda, el dental, el postoperatorio, el dolor muscular y para la 

artritis. Esto sugiere que TRPM8 podría tener un papel importante en la analgesia. A pesar de que el mentol 

puede actuar sobre varias dianas moleculares una de las cuales son los receptores GABA, la analgesia que 

produce se ha comprobado que es a través de TRPM8.  

El canal TRPM8 se ha encontrado en tejidos de cáncer de próstata y se ha convertido en una diana 

para la detección y tratamiento del cáncer. Recientemente se ha observado un aumento en los niveles de 

ARNm del canal, en sangre y orina de pacientes con cáncer de próstata en metástasis. TRPM8 se localiza en la 

membrana plasmática y en el retículo endoplasmatico de las células cancerosas de la próstata, donde 

probablemente regule los niveles de Ca
2+

 intracelular, necesarios para la viabilidad y proliferación de las células 

cancerosas. La inactivación de TRPM8 por medio de un ARN de interferencia, ha dado como resultado una 

disminución en el grado de proliferación de dichas células. Después del cáncer de próstata se han estudiado 

otros tipos de cáncer como el de mama, el neuroendocrino o el melanoma, en busca de TRPM8, y 

efectivamente se ha encontrado.  

En resumen, TRPM8 resulta ser una diana terapéutica prometedora, al estar involucrado en multitud 

de estados patológicos y distintos tipos de cáncer. La búsqueda de moduladores eficaces permitiría tratar los 

problemas de salud relacionados, además de ayudar a entender mejor los mecanismos moleculares 

involucrados.  

1.2. Modelado por homología 

Dada la inexistencia de un modelo 3D del canal TRPM8 hasta el momento y dada la importancia de 

éste para realizar el presente trabajo, la primera tarea a llevar a cabo para seguir adelante fue modelar el canal 

por homología. Para ello se utilizó la estructura 3D existente del canal TRPV1 debido a la gran homología 

estructural entre ambos.  

Uno de los mecanismos evolutivos es la duplicación de genes asociada a mutaciones, lo que conlleva a 

una divergencia y por tanto a la formación de familias de proteínas relacionadas, con secuencias aminoacídicas 

y estructuras 3D parecidas. Las proteínas que cumplen dichas premisas llevan el nombre de proteínas 

homólogas. En realidad, la secuencia de aminoácidos entre proteínas homólogas está menos conservada que la 

similitud estructural entre ellas. Esto se debe a que las diferencias más drásticas se encuentran en regiones de 

la superficie de la proteína, los denominados bucles. En estas regiones incluso las propiedades fisicoquímicas 

de las cadenas laterales pueden cambiar, sin embargo, en el interior de la proteína, los residuos varían con 

menor frecuencia. Esto conlleva a la generación de un núcleo común, con las estructuras secundarias 
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altamente conservadas entre las proteínas homólogas. Las estructuras secundarias de proteínas homólogas 

pueden cambiar de longitud o moverse en relación una hacia la otra, pero en general una hélice-α no se 

intercambia por una hoja-β, ni siquiera suele cambiar la orientación de ésta. Los aminoácidos involucrados en 

puentes salinos, enlaces de hidrógeno o puentes disulfuro es más probable que estén conservados también. En 

resumen, la conformación general de las proteínas homólogas está altamente conservada durante la evolución, 

hecho que forma la base del modelado por homología.  

Si se tuviera que modelar una proteína cuya estructura se desconoce por completo y no se tiene 

ninguna referencia de cómo podría ser, se deberían buscar las secuencias aminoacídicas más parecidas, y 

modelarla según la estructura de alguna de las proteínas encontradas. Sin embargo, hay que tener en cuenta 

que no todas las veces, la mejor opción, es la secuencia con mayor parecido, sino que tiene mayor importancia 

el parecido estructural. El proceso tradicional de modelado por homología comprende los siguientes pasos: 

Búsqueda de proteínas relacionadas con la proteína estudiada.  

En este caso la secuencia que debe ser modelada pertenece a una familia de proteínas bastante 

conocida. Sin embargo, para determinar qué miembro de las distintas subfamilias es conveniente utilizar para 

el modelado habría que basarse en una técnica central utilizada para comparar secuencias aminoacídicas 

denominada alineamiento de secuencias. Dicha técnica sirve para buscar en bases de datos para encontrar 

secuencias relativas y para identificar regiones en las proteínas encontradas que están conservadas, sugiriendo 

de este modo que la proteína estudiada presenta también partes estructuralmente conservadas. Si las 

secuencias son más largas de 100 aminoácidos y tienen una identidad mayor al 25% es muy probable que estén 

relacionadas. Si el grado de parecido está comprendido entre 15-25% entonces la probabilidad de relación 

disminuye pero sigue existiendo. Sin embargo, si el parecido está por debajo del 15%, es muy improbable que 

las proteínas estén relacionadas. Debido al paso crucial que representa el alineamiento de secuencias para el 

modelado por homología, han sido desarrollados varios métodos y distintos programas que siguen siendo 

perfeccionados. Uno de los primeros métodos fue el de Needleman y Wunsch cuya mayor ventaja es la 

garantía de la detección final del mejor alineamiento global entre dos secuencias. Por otra parte, otras 

aproximaciones buscan identificar el mejor alineamiento local y son importantes para la identificación de 

regiones altamente conservadas que están dispersas en secuencias largas.  

Durante la comparación de dos secuencias, los procedimientos de alineamiento buscan duplicar el 

proceso evolutivo que participa en la conversión de una secuencia en otra. Para esta operación se requiere un 

esquema de puntuación que dicta el peso de alinear un aminoácido con otro, denominada matriz. Las 

puntuaciones de éstas se basan en propiedades físicas, químicas o estadísticas de los aminoácidos, donde las 

altas puntuaciones indican que una determinada sustitución es probable.  

Hay que tener en cuenta que los alineamientos automáticos están lejos de la perfección y por eso 

deben ser siempre comprobados para ver si son razonables. En dichas comprobaciones debe incorporarse toda 

la información sobre los distintos grados de organización de las proteínas (primario, secundario y terciario).  
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Identificación y construcción de regiones estructuralmente conservadas (SCRs) 

 Existen regiones en las proteínas que pertenecen a una misma familia, que son casi idénticas en sus 

estructuras 3D. Son las así denominadas regiones estructuralmente conservadas (SCRs) que se corresponden 

con las estructuras secundarias hélices-α y hojas-β, que permiten la asignación de las coordenadas atómicas 

desde una proteína a otra que se pretende modelar.  

 Si se dispone de varías estructuras cristalográficas para asignar la estructura de una proteína de 

interés, se pueden superponer las estructuras 3D de las proteínas molde en busca de SCRs. Esta superposición 

es más complicada porque a priori se desconocen las partes que deberían encajar perfectamente y por tanto, 

hay que decidir qué átomos elegir para efectuar la superposición. Normalmente se utilizan los Cα y después, la 

superposición inicial se optimiza utilizando elementos estructurales secundarios. Hay que tener en cuenta que 

las estructuras secundarias deben asignarse antes de la búsqueda de SCRs. La forma más fácil para obtener 

información acerca de la estructura secundaria es a partir de los archivos cristalográficos, como los PDB. 

Además, existen programas para detectar elementos estructurales secundarios en base a características 

geométricas como el patrón de enlaces de hidrógeno o los ángulos diedros del esqueleto peptídico. 

Finalmente, las SCRs determinadas deben tener secuencias idénticas o muy parecidas. Debido a la similitud 

estructural de estas regiones, no se permiten huecos en las zonas conservadas.  

Construcción de las regiones estructuralmente variables (SVRs) 

 Dichas regiones se corresponden sobre todo con los bucles superficiales, cuya construcción es un reto. 

Dependiendo del caso se deberá seguir un método u otro. Una forma de conseguir modelar los giros es basarse 

en un segmento de tamaño equivalente de una proteína homóloga. Distintos estudios han demostrado que en 

proteínas homólogas donde los giros de las regiones variables tengan la misma longitud y el mismo carácter 

aminoacídico, tienen la misma conformación, permitiendo la transferencia de coordenadas atómicas de la 

misma forma que para las SCRs.  

 Si no existen giros comparables, las SVRs se pueden construir a partir de segmentos peptídicos de 

otras proteínas que encajan adecuadamente en la configuración espacial de la proteína modelada y por tanto 

cumplen con unos criterios geométricos determinados. Este método recibe el nombre de búsqueda de bucles y 

basándose en las distancias y coordenadas de referencia que le son proporcionadas, da como resultado varios 

giros puntuados según lo bien que encajan en la estructura deseada. Este método tiene la ventaja de que todos 

los bucles proporcionados tienen una geometría razonable, sin embargo no garantiza que el segmento elegido 

encaje perfectamente en la estructura ya modelada de la proteína de interés, de forma que se pueden detectar 

solapamientos estéricos importantes. Si esto sucede, la técnica de generación de novo es la mejor opción.  

 Con esta aproximación se construye el esqueleto peptídico entre dos segmentos conservados 

utilizando valores aleatorios para todos los ángulos diedros del esqueleto. Existen varios algoritmos para 

optimizar la estrategia de búsqueda y minimizar el tiempo de cálculo. A pesar de ello, esta técnica se utiliza 

solo para giros formados por hasta 7 aminoácidos.  
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 Todos los giros generados por un método u otro, están lejos de la perfección, por lo que es 

conveniente realizar un refinamiento por medio de minimizaciones de energía que relaje las conformaciones 

de los giros y elimine los choques estéricos.  

Modelado de las cadenas laterales 

 La predicción de las numerosas conformaciones de las cadenas laterales es un problema mucho más 

complejo que la predicción de la conformación del esqueleto peptídico. Muchas de las cadenas laterales 

poseen varios grados de libertad y por tanto pueden adoptar varias conformaciones energéticamente 

permitidas. Se asume generalmente que residuos idénticos entre proteínas homólogas adoptan 

conformaciones similares. También cadenas de residuos de una misma pareja (Val e Ile o Gln y Glu) adoptan 

una misma orientación. Sin embargo, cuando los aminoácidos entre las proteínas homólogas no coinciden y en 

la proteína que se quiere modelar, la cadena lateral es más larga que la del aminoácido correspondiente de la 

proteína molde, la cadena lateral deberá adoptar una posición aleatoria que evite contactos indeseados con 

otras cadenas laterales. Existen librerías de rotámeros construidas a partir de las combinaciones de las 

posiciones anti- y gauche de cada cadena lateral. Seleccionar una conformación a partir de la librería puede 

resultar problemática ya que no se tendrá en cuenta la conformación de la cadena lateral del aminoácido 

correspondiente en la proteína homóloga, ni el entorno local al que se enfrenta la cadena lateral.  

 Por otra parte, las posiciones de las cadenas laterales deberán refinarse manualmente en casos 

especiales cuando el aminoácido forma interacciones específicas como puentes disulfuro, puentes de 

hidrógeno internos o puentes iónicos. También, cuando el aminoácido se encuentra en la superficie y es 

totalmente accesible al medio. Igualmente, es conveniente utilizar la dinámica molecular para explorar la 

región local del espacio conformacional y refinar la estructura.  

1.3. Dinámica molecular 

Los modelos proteicos derivados a partir de modelado por homología necesitan un posterior 

refinamiento de la estructura tridimensional. En general, las cadenas laterales y los giros proteicos generados 

durante el modelado adoptan unas conformaciones que no se corresponden con estructuras razonables 

energéticamente. Debido a la gran cantidad de átomos que supone una proteína, la única forma de conseguir 

dicho refinamiento es mediante cálculos de dinámica molecular. Este método se basa en las implicaciones de la 

Mecánica Molecular donde los electrones y el núcleo de los átomos no se incluyen explícitamente. La Mecánica 

Molecular a diferencia de la Mecánica Quántica, considera que la composición atómica de las moléculas es una 

colección de masas interactuando entre sí por medio de fuerzas armónicas. Los átomos se toman como esferas 

de diferentes tamaños unidas entre sí por muelles de distinta longitud. Para calcular la energía potencial del 

conjunto de átomos se utiliza la ley de Hooke. 

      , 

donde F es la fuerza ejercida en el muelle con el alargamiento δ producido y k es la constante elástica. 
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El objetivo principal de la dinámica molecular es reproducir el movimiento de una molécula, 

dependiendo del tiempo. A intervalos regulares de tiempo, se resuelve la ecuación de la segunda ley de 

Newton: 

              , 

donde Fi es la fuerza ejercida sobre el átomo i a tiempo t, mi es la masa del átomo i y ai es la aceleración del 

átomo i a tiempo t.  

En base a las coordenadas atómicas iniciales del sistema se pueden calcular nuevas posiciones y 

velocidades para los átomos a tiempo t. Como resultado de este procedimiento se crea una nueva 

conformación. La dinámica molecular es capaz de superar barreras de energía entre las diferentes 

conformaciones de una molécula. De esta forma sería capaz de encontrar otros mínimos locales que se 

encuentran en la superficie de energía potencial. A pesar de ello, si las barreras energéticas son demasiado 

grandes o si existen muchos grados de libertad para la molécula, algunos de los confórmeros existentes no se 

podrían alcanzar. Un punto importante en todos los protocolos de dinámica molecular es la elección de la 

temperatura de simulación. Normalmente, las simulaciones se realizan a temperaturas comprendidas entre 

300 y 400 K. Por una parte, la temperatura debe ser suficientemente elevada como para evitar que el sistema 

se quede atrapado en una región particular del espacio conformacional, pero por otra, no debe ser demasiado 

elevada para no resultar en conformaciones distorsionadas de elevada energía. Otro problema que causa la 

elevada temperatura en las simulaciones de péptidos y proteínas, es la interconversión de enlaces peptídicos 

del estado trans al cis.  

En muchos casos, el algoritmo del descenso más pronunciado (steepest descent) es el primero en 

utilizarse. Este método utiliza la primera derivada de la función de energía para aproximarse al mínimo 

energético. La energía se calcula para la geometría inicial y para las nuevas geometrías que se generan cuando 

alguno de los átomos se mueve en alguna dirección. El proceso se repite para todos los átomos resultando en 

un posicionamiento cuesta abajo en la superficie de energía potencial. El proceso de optimización se hace más 

lento cuanto más se aproxima al mínimo global, por lo que este método se utiliza para estructuras que se 

encuentran lejos de dicho mínimo.  

Se considera que los átomos de la molécula interaccionan entre sí según las reglas del campo de 

fuerza utilizado. Éstos se basan en las ecuaciones de energía potencial. Los campos de fuerzas utilizados para 

proteínas o macromoléculas en general, presentan simplificaciones como incluir los átomos de hidrógeno 

apolares en las descripciones de los átomos pesados a los que están unidos, en vez de representarlos 

explícitamente. También se introducen radios de corte para reducir el tiempo de cálculo de las interacciones 

débiles entre átomos separadas por distancias mayores al límite fijado. Debe tenerse en cuenta que cada 

simplificación añadida puede resultar en una pérdida de exactitud en el resultado obtenido. Para conseguir una 

mayor reducción en el tiempo de cálculo, diversas partes de la proteína pueden mantenerse rígidas, llevando a 

cabo entonces las simulaciones de dinámica molecular solo para las partes flexibles como cadenas laterales o 

giros.  

El campo de fuerza utilizado para las simulaciones de dinámica molecular para el canal TRPM8 fue 

YASARA2 implementado en el programa YASARA (http://www.yasara.org). Éste ha sido optimizado para 
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predicción de estructuras, refinamiento, minimización de energía y validación, y se utiliza sobre todo para 

refinamiento de estructuras obtenidas por modelado por homología. Contiene potenciales diedros y 

potenciales de interacción basados en el conocimiento que dan resultados más precisos de los modelos 

proteicos refinados, en comparación con otros campos de fuerza.  

1.4. Cribado virtual 

El cribado de alto rendimiento (HTS) de librerías químicas es un método bien establecido para 

encontrar nuevos compuestos líderes durante el descubrimiento de fármacos. A pesar de ello, debido a que las 

librerías de compuestos aumentan cada vez más su tamaño, los costes de cribado se ven incrementados, 

mientras que el nivel de acierto disminuye. Este problema se podría solucionar si, en vez de cribar 

experimentalmente toda la librería, sólo se cribase una parte pequeña de compuestos propensos a unirse al 

receptor. Esta preselección podría realizarse mediante cribado virtual (VS), un método computacional utilizado 

en la selección de los compuestos más prometedores de una librería química. Para limitar el número de 

compuestos a cribar se pueden utilizar distintos filtros, uno de los cuales es la Regla del 5 de Lipinski. A pesar 

de que en el caso de este trabajo el número de compuestos a cribar es limitado, se comprobó que todos ellos 

cumplieran con dicha regla ya que de lo contrario podrían presentar una baja absorción o permeabilidad en los 

ensayos experimentales, y no ser unos buenos candidatos farmacológicos.  

Los trabajos de cribado pueden ser rígidos, semiflexibles o flexibles y realizarse considerando al 

receptor y al ligando como moléculas rígidas, al receptor como rígido y a los ligandos como flexibles o a ambos 

elementos como flexibles, respectivamente. También, en el cribado semiflexible se puede tratar a unas pocas 

cadenas laterales del receptor como flexibles y mantener el resto de la estructura rígida. Debido a que las 

proteínas son moléculas altamente flexibles, a la hora de realizar el cribado virtual, lo mejor sería tratar al 

receptor como flexible. Sin embargo, dada la gran carga computacional que implicaría, requeriría de 

ordenadores más potentes, con mayor capacidad de disco duro, RAM y procesador. Por tanto, para agilizar el 

trabajo, podría elegirse una de las siguientes dos opciones: a) considerar el receptor totalmente rígido y al 

ligando totalmente flexible, ya que los ligandos son moléculas mucho más pequeñas y su flexibilidad es más 

fácil de considerar, o b) considerar el receptor semiflexible dando libertad de movimiento a algunas cadenas 

laterales, y el ligando totalmente flexible. En este segundo caso es necesario conocer el sitio de unión del 

ligando.  

Para el presente trabajo de cribado virtual se tienen datos estructurales de la proteína diana, así como, 

se conocen varías moléculas activas que se unen a ella para modularla. El método más idóneo a utilizar, es el de 

acoplamiento proteína-ligando o cribado virtual basado en estructura, donde se busca la complementariedad 

electrónica y estérica entre los ligandos y la diana macromolecular. A pesar de que se conocen varios sitios de 

unión de moléculas moduladoras del canal, el cribado realizado es global, es decir, sin determinar un bolsillo de 

unión específico donde se tengan que acoplar los ligandos. El programa YASARA permite mantener el ligando 

completamente rígido o darle flexibilidad. También permite mantener flexibles distintas partes de la proteína 

diana, especificando los residuos correspondientes. Los parámetros “rigid” y “flexres” que corresponden al 
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control de la flexibilidad del ligando y la proteína, respectivamente, se mantuvieron con los valores 

predeterminados, es decir, el cribado se realizó con los ligando flexibles y la proteína completamente rígida.   

Es necesario evaluar y clasificar los distintos acoplamientos ligando-proteína para identificar el modo 

de unión más probable y asignarle una prioridad. La evaluación se realiza asignando a cada ligando una 

puntuación proveniente de funciones relacionadas con la energía libre de asociación entre las dos moléculas 

(proteína-ligando). La energía libre de unión proviene de la ecuación de Gibbs – Helmhontz: 

         , 

donde  G es la energía libre de unión,  H es la entalpía, T es la temperatura en grados Kelvin y  S, la entropía. 

 G se relaciona con la constante de unión Ki por la ecuación: 

          , 

donde R es la constante de los gases.  

 Existe una gran variedad de técnicas distintas para predecir la energía libre de unión de pequeñas 

moléculas en base a una estructura 3D dada. Estas técnicas se diferencian significativamente en cuanto a 

velocidad y precisión. Si lo que se quiere predecir es la diferencia de energía libre de unión entre un ligando y 

una molécula de referencia, de forma muy precisa aunque muy lenta, se recomienda el uso de las 

perturbaciones de energía libre. Si por otra parte, el objetivo principal es comparar las energías libres de unión 

de varios cientos de complejos ligando-proteína, con mucha mayor rapidez, se deben utilizar funciones de 

puntuación de menor precisión. Las funciones de puntuación se pueden dividir en tres grupos: funciones de 

puntuación empíricas, funciones basadas en el campo de fuerza y potenciales basados en conocimiento. En el 

cribado virtual, las funciones de puntuación se utilizan con dos propósitos: durante el proceso de cribado sirven 

para optimizar el posicionamiento del ligando, mientras que después de completar el cribado, se utilizan para 

clasificar a los ligandos como ya se mencionó anteriormente.  

El campo de fuerza utilizado por YASARA para llevar a cabo los trabajos de cribado virtual es el 

AMBER03 (Duan Y et al., 2003), que ha sido desarrollado para usos generales en cualquier tipo de aplicación. La 

función de puntuación utilizada en este caso se basa en el potencial de Lenard-Jones que describe las 

interacciones van der Waals y en la energía de Coulomb que describe los componentes electrostáticos de la 

interacción. La función de energía tiene la siguiente forma: 

     
   

   
 

   

  
    

    

    
 

   

   

   

   

 

donde Aij y Bij son los parámetros de repulsión y atracción de van der Waals entre los átomos i y j a una 

distancia rij, qi y qj son las cargas puntuales de los átomos i y j, D es la constante dieléctrica y 332 es una factor 

que convierte la energía electrostática en kilocalorías por mol. La mayor desventaja de esta función de energía 

es la omisión del componente entrópico de la energía libre de unión.  
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2. Antecedentes y objetivos 

2.1. Antecedentes 

Se ha observado que varios fármacos utilizados en quimioterapia para tratar distintos tipos de cáncer, 

causan efectos secundarios como la neuropatía periférica, agravada por el frío, que limita la dosis utilizada y 

compromete seriamente la eficacia de los tratamientos. Un ejemplo de dichos fármacos es el oxaliplatino, 

utilizado en el tratamiento del cáncer de páncreas y el cáncer colorrectal.  

Dado el papel primordial que recibe el canal TRPM8 en la sensibilización hacia el frío, se piensa que un 

inhibidor de dicho canal iónico podría aliviar los síntomas. Sin embargo, la búsqueda debe centrarse en 

antagonistas no competitivos o en bloqueadores de canal abierto, ya que los antagonistas competitivos 

podrían producir efectos secundarios indeseados.  

La existencia de un modelo estructural del canal iónico TRPV1 de Liao M. et al., 2013, ha permitido crear 

un modelo por homología del canal TRPM8 que facilitará la búsqueda de moduladores específicos de dicho 

canal iónico.   

2.2. Objetivos 

2.2.1. Generales 

Desarrollo de nuevos moduladores TRPM8 basados en el conocimiento detallado de la estructura y la 

actividad del canal TRPM8. 

2.2.2. Específicos 

 Modelado de TRPM8 en estado abierto, con modificación de los bucles extracelulares, análisis de la 

estructura y minimización de la energía por dinámica molecular. 

 Definición de una librería de compuestos orgánicos que serán chequeados frente al modelo TRPM8 

mediante cribado virtual computacional basado en estructura. 

 Descubrimiento de antagonistas no competitivos de TRPM8 capaces de unirse específicamente al 

estado abierto del canal, lo que permitirá bloquear preferentemente receptores muy activados, frente a 

canales poco activos o silentes. 

3. Materiales y métodos 

3.1. Modelado por homología de TRPM8 a partir de TRPV1. 

Tener un modelo fiable del canal TRPM8 representa un paso fundamental en la búsqueda de moduladores 

de su actividad. A pesar de que existan modelos de TRPM8 a partir de canales de potasio (Kv) cuya estructura 

ha sido determinada por cristalografía de rayos-X, no se sabe hasta qué punto la familia TRP comparte 

similitudes estructurales con estos. Dado que la obtención de cristales de proteínas de membrana de 

mamíferos constituye un reto, sobre todo para canales TRP que responden a diversos estímulos y son por tanto 

altamente dinámicos, recientemente se ha optado por el uso de la crio-electromicroscopía de partícula única 

(cryo-EM) para la reconstrucción tridimensional de grandes complejos proteicos con resolución casi atómica. 
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Dicha técnica ha sido utilizada para la determinación de la estructura del canal TRPV1 en los estados abierto y 

cerrado, llegando a una resolución de  .    y  .   , respectivamente (Liao M. et al., 2013; Cao E. et al., 2013). 

Al pertenecer a la misma familia de canales iónicos, se esperaría que TRPV1 y TRPM8 tuviesen mayor parecido 

estructural entre sí que TRPM8 y los canales de potasio. Es por eso que TRPM8 fue modelado a partir de 

TRPV1, en los estados abierto y cerrado.  

3.2. Construcción de giros extracelulares del estado abierto del canal TRPM8 

Debido a que el modelo inicial del canal en estado abierto presentaba unos giros extracelulares 

incorrectos, tal y como se puede observar en la Figura 1, éstos fueron reemplazados por los giros del canal en 

estado cerrado donde ya habían sido conseguidos anteriormente. Para dicho fin se utilizó el programa YASARA 

(http://www.yasara.org) debido a las posibilidades que ofrece para el reemplazo de dominios de proteínas. 

Antes de todo, se alinearon estructuralmente los modelos de los dos estados del canal, por el método 

MUSTANG (Konagurthu AS et al, 2006), que utiliza un algoritmo para alineamiento estructural múltiple 

utilizado para proteínas (Analyze>Align>Objects with MUSTANG), para visualizar los mejores puntos de 

solapamiento entre sus giros (Figura 2), intentando a la vez conservar su total integridad. Se determinó que los 

mejores puntos de corte en cada una de las subunidades del canal serían Phe 712, Ser 733, Leu 889 y Pro 958. 

De esta forma, el reemplazo realizado fue entre los segmentos Phe 712 – Ser 733 y Leu 889 – Pro 958 de cada 

subunidad, del estado abierto por los del estado cerrado. Para lograrlo se siguieron los pasos siguientes: 

 Eliminar las partes de la proteína en cada estado que no interesan (Edit>Delete>Residue y seleccionar 

los residuos que se quieran eliminar). En este caso, los giros extracelulares del estado abierto y el canal 

completo excepto los giros del estado cerrado.  

 Crear puntos de corte en la proteína en estado abierto para poder insertar los segmentos 

anteriormente mencionados de la proteína en estado cerrado (Edit>Split>Residue y seleccionar el residuo 

donde se quiera realizar el corte). A continuación se debe dividir el objeto principal en objetos hijos para poder 

unir al final todos los objetos en uno (En la ventana de “Scene Content”, botón derecho sobre el objeto principal 

y seleccionar Split). 

 Unir los distintos segmentos utilizando el comando JoinObj X, Y (se une el objeto X al Y, quedando el X 

vacío; se debe tener en cuenta la secuencia numérica de los residuos de cada segmento).  

 Finalmente se deben crear los enlaces peptídicos correspondientes en cada corte. Para ello se utiliza el 

comando AddBond Z, W, 1. Z y W se corresponden con el número concreto de cada átomo de carbono y 

nitrógeno entre los que se quiera crear el enlace. 1 se corresponde con el tipo de enlace que se quiera crear, 

siendo en este caso, un enlace simple.  
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Figura 1. Los bucles del estado cerrado (rojo) ya habían sido corregidos previamente, y se había creado un puente 
disulfuro entre C929 y C940. Dado que el modelo abierto presentó bucles incorrectos a), se procedió a trasplantar dichos 
bucles desde el estado cerrado al abierto, obteniendo un modelo abierto corregido b). 

 

Figura 2. Se ilustran los aminoácidos considerados en ser los mejores puntos de corte para la inserción de los bucles 
desde el modelo cerrado hasta el abierto. A pesar de que en algunos casos, el aminoácido proveniente de la proteína en 
estado cerrado adopta una estructura secundaria distinta, la estructura del canal en estado abierto con los nuevos bucles 
se ha mantenido igual que la original.  

3.3. Análisis del nuevo modelo del canal en estado abierto 

Con el fin de comprobar la existencia de cualquier error que se haya podido producir durante la 

construcción de los giros correctos del canal en estado abierto, tanto en cuanto a deleciones como a 

duplicaciones de cualquier aminoácido, se buscó la secuencia de aminoácidos del canal 

TRPM8 de rata en la base de datos UniProt y se realizó un alineamiento mediante el 

programa ClustalW entre dicha secuencia y la secuencia del canal en estado abierto 

extraída mediante el programa SPDBV, en formato fasta. Tal y como se puede observar 

en el Anexo 1, no hubo ninguna mutación en la secuencia del canal en estado abierto.  

Además, para validar estructuralmente el nuevo modelo del canal en estado 

abierto, se llevó a cabo un análisis mediante el programa YASARA 

(Analyze>Check>All>Elegir parámetro) que muestra como resultado un valor de Z, que 

clasifica el modelo en bueno o malo según la escala de la Tabla 1. Los parámetros 

analizados fueron la exactitud de los estereoisómeros o la presencia de D-aminoácidos en la proteína (Isomers), 

la presencia de enlaces peptídicos en cis (PepBonds), y la normalidad de la longitud de los enlaces (Bonds), de 

Tabla 1. Escala de valores 
Z y su significado. 
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los ángulos de los enlaces (Angles), de los ángulos diedros (Dihedrals), de la planaridad de los ángulos diedros 

(Planarity), de las interacciones de Coulomb y Van der Waals (NonBonded), de las interacciones de 

empaquetamiento dependientes de distancia unidimensional en el campo de fuerza YASARA2 (Packing1D), de 

las interacciones de empaquetamiento dependientes de distancia tridimensional en el campo de fuerza 

YASARA2 (Packing3D) y finalmente la calidad global del modelo (ModelQuality) determinada por tres de los 

parámetros anteriores (Dihedrals, Packing1D y Packing3D). Hay que tener en consideración que los valores de Z 

se obtienen comparando la estructura de la proteína con un estándar de referencias estructurales. Dichas 

referencias no son proteínas de membrana y en general los valores de Z obtenidos de esta forma son muy 

bajos. Sin embargo, esto no significa que el modelo de la proteína de interés sea incorrecto.  

El análisis se realizó dos veces, la primera antes de llevar a cabo la minimización de energía por 

dinámica molecular y la segunda, después. La forma de efectuar dicha minimización se explicará en el siguiente 

subapartado. En la siguiente tabla se muestran los distintos valores de Z obtenidos para cada parámetro, en las 

dos fases mencionadas anteriormente.  

Parámetro analizado Antes de la minimización de energía Después de la minimización de energía 

*Estereoisómeros (Isomers) 8 0 

*Enlaces peptídicos (PepBonds) 16 16 

Longitud de enlace (Bonds) -1.725 -1.020 

Ángulos de enlace (Angles) -0.371 0.031 

Ángulos diedros (Dihedrals) -2.356 -2.183 

Planaridad (Planarity) -1.119 -0.635 

Interacciones débiles (NonBonded) -146.531 -0.748 

(Packing1D) -3.253 -2.929 

(Packing3D) -3.788 -3.693 

Calidad global (ModelQuality) -3.372 -3.176 

Tabla 2. Resultados de la calidad estructural del estado abierto antes y después de la minimización de energía. Los dos 
parámetros que aparecen con el símbolo (*) no siguen la escala de valores Z anterior, sino que cuanto más se acercan a 
cero, mayor es la calidad de modelo ya que no deben haber D-aminoácidos, y la presencia de enlaces cis es condicional y 
dependiente de la estructura secundaria donde se encuentran.  

Por medio del análisis se encontraron 8 D-aminoácidos, que fueron HIS 928 y CYS 929 en las cuatro 

subunidades. Utilizando YASARA, éstos se cambiaron a L-aminoácidos mediante la opción Swap>Residue 

haciendo clic con el botón derecho sobre el aminoácido que se quera cambiar. Se tuvo en cuenta que el 

residuo CYS 929 forma un puente disulfuro con el residuo CYS 940, y que al cambiar su configuración, este 

puente probablemente se romperá. Debido a este hecho se volvió a reconstruir. Para hacerlo se mutaron los 

residuos de cisteína que participan en la formación del enlace (Botón derecho sobre el residuo>Swap>Cyx) y se 

creó el enlace sencillo entre los dos residuos (Seleccionar ambos residuos>Botón derecho>Add>Bond>Single). 

Finalmente, por dinámica molecular se relajaron los nuevos enlaces formados.  

En cuanto a los enlaces peptídicos cis, se encontraron 16, 8 de los cuales pertenecían a residuos de 

prolina, PRO 764 y PRO 938 en las cuatro subunidades, por lo que no hizo falta cambiarlos. Por otra parte, los 8 
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enlaces restantes se encontraron en residuos no-prolina, ASP 920 y GLU 942 en las cuatro subunidades. Debido 

a que la configuración del enlace peptídico es dependiente de la estructura secundaria que adoptan los 

residuos entre los que se forma, al pertenecer ASP 920 y GLU 942 a una estructura secundaria con mayores 

grados de libertad, como son los giros, tampoco hizo falta cambiarlos, ya que no desestabilizan la estructura.  

Tal y como se puede observar en la Tabla 2., la minimización de energía en el modelo ha mejorado el 

valor de Z en la totalidad de los parámetros, sobretodo en el caso de las interacciones débiles, debido a la 

disminución de los choques estéricos entre los distintos elementos.  

3.4. Minimización de energía mediante dinámica molecular 

La minimización de energía por dinámica molecular se hizo con los modelos de ambos estados del 

canal, el abierto y el cerrado y para ello, se utilizó el programa YASARA. Para ejecutar la simulación se debe 

elegir un campo de fuerza, en este caso YASARA2 (S   la on  orce   eld   S      C to   ,    >Set these 

two parameters instead), fijar una celdilla de simulación alrededor de la proteína completa (Simulation>Define 

simulation cell>Extend  ,    aro nd all ato s), fijar la parte de la proteína que no debe moverse durante la 

simulación, que en este caso es el esqueleto peptídico de la proteína excepto el de los giros extracelulares. Para 

ello, en la consola se escribe FixAtom backbone Mol X (donde X es el nombre que recibe la molécula en 

YASARA), fijando todo el esqueleto peptídico sin las cadenas laterales y FreeRes Z-Y Mol X (donde Z-Y 

corresponde al intervalo de residuos que se quieren liberar, en este caso los giros extracelulares 712-733 y 889-

958). Finalmente se debe controlar la temperatura de simulación (Simulation>Temperature control>Steepest 

descent minimization). El control de temperatura se puede efectuar también directamente desde el panel de 

“S   lat on Para eters”, que se muestra al presionar “Crtl + Insert”. El control se realiza con la tecla F10. Al ver 

que la simulación bajo este control de temperatura no efectuaba muchos cambios en la estructura de la 

proteína, se decidió, realizarla bajo el control de temperatura “Step-1  anneal ng” donde el cambio de 

temperatura es más pronunciado. Para iniciar la simulación se debe presionar F12 y dejarla durante unos 1000 

fs. Hay que tener en cuenta que cuanto más extrema es la temperatura de la simulación, los cambios en la 

estructura se producen con mayor rapidez.  

3.5. Librería de compuestos – construcción y análisis 

A partir de la lista de ligandos seleccionada al principio del presente trabajo debido a la similitud 

estructural de los compuestos con la serotonina y la melatonina que tienen efecto sobre distintos receptores 

celulares, se comprobaron todos los archivos .sdf para ver la coincidencia en la estructura con la presente en la 

base de datos PubChem. Cualquier cambio estructural en los ligandos se efectuó con el programa Marvin 

Sketch (https://www.chemaxon.com/products/marvin/marvinsketch/). Después se analizaron las 

características físico-químicas de los ligandos con el programa Marvin View. Los parámetros analizados fueron 

el peso molecular (Tools>Elemental analysis), el número de aceptores y donadores de puentes de hidrógeno 

(Tools>Other>H Bond Donor/Acceptor), el punto isoeléctrico (Tools>Protonation>Isoelectric Point), el 

coeficiente de partición octanol-agua (logP) (Tools>Partioning>LogP) y la polarizabilidad de la molécula 

(Tools>Charge>Polarizability). Además para obtener el nombre exacto según la IUPAC, se utilizó la opción 
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Tools>Naming. Los parámetros anteriores fueron analizados para comprobar si cada molécula cumple con las 

reglas de Lipinski importantes durante la búsqueda de nuevos fármacos. Según dicha regla, el peso molecular 

debe ser menor de 500 Da, los donadores de puentes de hidrógeno deben ser menos de 5, los aceptores de 

puentes de hidrógeno deben ser menos de 10 y el coeficiente de partición octanol-agua (logP) que determina 

la hidrofobicidad de la molécula debe ser menor de 5.  

 

 

Tabla 3. Recoge a los compuestos elegidos para realizar el cribado virtual computacional. Las características detalladas de 
cada uno son el nombre común o en caso de no existir, el nombre que recibe en la base de datos, su nomenclatura según 
la IUPAC, el peso molecular en Daltons, el número de donadores y aceptores de puentes de hidrógeno, el punto 
isoeléctrico y el coeficiente de partición octanol-agua (LogP).  
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Tabla 3bis. Recoge a los compuestos elegidos para realizar el cribado virtual computacional. Las características detalladas 
de cada uno son el nombre común o en caso de no existir, el nombre que recibe en la base de datos, su nomenclatura 
según la IUPAC, el peso molecular en Daltons, el número de donadores y aceptores de puentes de hidrógeno, el punto 
isoeléctrico y el coeficiente de partición octanol-agua (LogP).  

3.6. Lanzamiento de trabajos de cribado virtual al servidor Proteo.  

Para poder realizar el cribado virtual de todos los ligandos con YASARA, se necesitan archivos .pdb. 

Para ello se utilizó el programa OpenBabelGUI (http://openbabel.org/) que tiene la capacidad de convertir unos 

formatos de archivo en otros, convirtiendo los archivos .sdf de los ligandos en .pdb. Para llevar a cabo el 

cribado global con el programa YASARA mediante el método VINA, es decir, sin fijar una región donde debe 

producirse la interacción ligando-receptor, se crean dos archivos .pdb que reciben el mismo nombre pero se 

diferencian en la terminación. Ésta debe ser _ligand para el ligando y _receptor para el receptor. A 

continuación se debe preparar el macro, un archivo de texto con formato .mcr, que contiene el script con las 

instrucciones para ejecutar el cribado. El script completo se puede visualizar en el Anexo 2 bajo el nombre 

dock_run.mcr. Las dos principales líneas que se deben acomodar a cada trabajo son la ruta principal donde se 

encuentran los archivos del ligando y el receptor y el número de acoplamientos a realizar, que cuanto mayor 

es, mayor significancia estadística tendrá el resultado del cribado, pero necesitará mayor tiempo de cálculo. En 

este caso se eligió que cada cribado se repetiría 500 veces. Ambas líneas aparecen remarcadas en el Anexo 2. 
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Una vez preparado el script, debe moverse a la misma carpeta donde se encuentran los archivos del ligando y 

el receptor. Finalmente, desde la terminal, se llega hasta dicha carpeta y se ejecuta el macro mediante el 

programa YASARA. Este programa debe ejecutarse en formato texto para requerir una menor capacidad de 

cálculo del servidor y agilizar el trabajo. El comando que debe ejecutarse en la carpeta de trabajo es el 

siguiente:  

nohup /home/… ruta hasta llegar a la carpeta de YASARA/ yasara –txt dock_run.mcr > log_trabajoX.txt & 

“noh p … &” es un comando que libera el ordenador personal del peso del cálculo una vez lanzado al servidor. 

“yasara –txt” es el comando para ejecutar el programa YASARA en formato de texto, sin un entorno gráfico 

pesado. “dock_run.mcr” es el macro a ejecutar mediante YASARA. Finalmente, “> log_trabajoX.txt” es un 

comando que indica al programa escribir todo el progreso del cálculo, incluido cualquier tipo de error que se 

puede dar, además del resultado final, en un archivo de texto que recibe el nombre de log_trabajoX.txt. 

Algunas consideraciones a tener en cuenta son que los ligandos en cuyo archivo existen dos moléculas que 

actúan como contraiones como es el caso de 4-acetoxyDMT (HCl) y AMTB (HF) no se pueden cribar 

directamente y antes deben eliminarse dichas moléculas pequeñas. Por otra parte, hay que asegurarse de que 

el receptor no presenta ningún residuo o átomo suelto del resto de proteína.  

 En el caso del cribado virtual local realizado para algunos de los ligandos, el método a seguir es muy 

parecido. Primero se debe preparar una escena de YASARA con el receptor y el ligando en la posición donde se 

quiere cribar, envuelto por una celda de simulación. El archivo que se crea es por tanto un complejo que 

contiene a estos tres elementos. Debe utilizarse el script “dock_runlocal.mcr”, muy parecido al script anterior, 

pero en él debe especificarse el programa que se quiere utilizar para realizar el cribado, en este caso 

AutoDockLS, el número de intentos de cribado y finalmente los residuos cuyas cadenas laterales se quieren 

dejar sin fijar, que en este caso fueron Asn741, Tyr745 y Tyr826, por estar más próximos al ligando.  

3.7. Análisis de los resultados del cribado virtual 

Los archivos que se crean por YASARA una vez finalizado el trabajo de cribado tienen el formato .yob y 

representan a cada uno de los agrupamientos o clusters creados por el programa, debido a la coincidencia del 

sitio de interacción en cada uno de los 500 intentos de cribado. Además se crea un archivo con extensión .sce, 

que representa a una escena en el programa donde están agrupados todos los clusters anteriores. Para 

visualizar los sitios de interacción de los ligandos con la proteína se utilizó el macro dock_play.mcr, desde 

YASARA (Options>Macro & Movie >Play macro).  

Adicionalmente se utilizaron dos scripts para agilizar el análisis de los resultados. El primero de ellos 

analiza el archivo de texto donde se vuelcan los resultados para organizarlos, indicando el número de intentos 

de cribado de cada ligando que muestran interacción con una, dos, tres o cuatro subunidades de la proteína, 

además de los residuos donde se produce la interacción. Asimismo, efectúa la misma tarea, utilizando la 

proporción de clusters o agrupamientos. Finalmente, proporciona otro archivo de texto donde resume lo 

anterior, mostrando solamente el porcentaje de intentos de cribado según el número de subunidades con las 

que hay interacción. Repite lo mismo para los clusters. Para ejecutarlo se utiliza el programa Python IDLE. El 

script completo se puede visualizar en el Anexo 3.  
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El segundo de ellos, se ejecuta mediante YASARA. Sirve para realizar una búsqueda entre los 

resultados obtenidos y comprobar si ha habido interacción entre los ligandos y alguna zona determinada de la 

proteína que nos interesa. Dicha zona debe especificarse en el script. Si hay distintas zonas que se quieren 

comprobar, el script debe ejecutarse con distinto nombre final para no escribir sobre resultados anteriores, ya 

obtenidos. Además debe especificarse el nombre que recibe el ligando en YASARA. Ese nombre es de tres letras 

y algunas de las posibilidades son UNK o LIG. El script completo puede verse en el Anexo 4. Se han resaltado las 

líneas que deben modificarse según cada caso. Los residuos que fueron comprobados para la interacción con 

los ligandos son 712-733 y 889-958 que corresponden a los giros extracelulares. Estos fueron elegidos debido a 

que se sospecha que algunas moléculas que interaccionan con el canal TRPM8 lo hacen a través de esta 

estructura. También se comprobaron los residuos 742-750, 842 y 856 (Bandell. M et al., 2006) ya que 

corresponden al sitio de unión del mentol y además se ha visto que son el sitio de unión de varios antagonistas 

del canal (Malkia A. et al., 2009). Y finalmente, los residuos 799, 802-806, correspondientes al sitio de unión de 

la icilina.  

4. Resultados 

4.1. Análisis de interacción global  

La Figura 3 muestra las interacciones de los ligandos con los estados abierto y cerrado del canal, según 

el número de cadenas con las que se producen dichas uniones. Del análisis de la interacción de los ligandos con 

el estado cerrado del canal queda claro que hay una tendencia por la unión a una única subunidad de la 

proteína. Aun así, se observa aunque con bajo porcentaje, que algunos de los ligandos tienden a unirse a la vez 

a dos de las subunidades. Finalmente, existen tres ligandos (4-acetoxyDMT, 6-hidroximelatonina y AMTB) que 

se unen a las cuatro subunidades del canal a la vez, quedando en una posición central del canal. El análisis de 

los clusters que interaccionan con ese mismo estado del canal muestra unos resultados muy parecidos, lo que 

es de esperar ya que los clusters son simplemente agrupaciones de intentos de cribado en los que el ligando se 

posiciona cerca de unos determinados residuos.  

En cuanto al estado abierto del canal se observa que casi el mismo porcentaje de ligandos tienden a 

unirse tanto a una como a dos de las subunidades del canal. Este hecho puede deberse a la posibilidad de que 

el canal abierto forme sitios de unión entre dos subunidades que no están formados, o no completamente, en 

el estado cerrado, a pesar de que la diferencia entre ambos estados sea mínima. Finalmente, hay solamente 

dos ligandos (4-acetoxyDMT y AMTB) que interaccionan con las cuatro subunidades a la vez. A pesar de que se 

podría pensar que estos ligandos fuesen bloqueadores de canal abierto, por localizarse en el centro del poro, 

esto resulta improbable ya que esta interacción debería darse solamente en el caso del canal en estado 

abierto. Hay que resaltar también que debido al cambio tan pequeño en el canal entre sus dos estados, 

posiblemente no permita limitar la unión de los ligandos anteriores a un estado determinado del canal. 

En ninguno de los casos se puede observar interacción de los ligandos con tres de las subunidades, lo 

cual se debe a la forma del canal, centrada en el poro, la cual limita las posiciones que pueden ocupar los 

ligandos para unirse solamente a tres subunidades.  
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Figura 3. Análisis de interacción global donde se representa el porcentaje de ligandos o de clusters frente al número de 
cadenas con las que interaccionan, en el estado abierto y cerrado del canal. 

4.2. Análisis de interacción individual 

La interacción de cada ligando con el receptor se analizó individualmente fijándose en el sitio concreto 

de unión. Se tuvieron en cuenta varios sitios ya conocidos como el del mentol, la icilina y los giros 

extracelulares en cuyo caso, aunque no se ha documentado una clara interacción con estos, existen sospechas 

de que se dé. La energía de unión fue clave para determinar la unión más probable de ocurrir. También se 

analizó la interacción con partes de la proteína que aunque no sean conocidas como sitio de unión de ninguna 

molécula, pueden tener alguna importancia por sus características y papel en la funcionalidad del canal.  

Dado que se trata de un modelo del canal TRPM8 construido a partir del canal TRPV1, en cuyo caso es 

posible que los residuos que forman parte del sitio de unión del mentol o la icilina se enfrenten a un entorno 

distinto, se realizó un cribado virtual local con la molécula de mentol y el estado cerrado del canal, para 

asegurarse de que se da una interacción entre dicha molécula y el residuo Tyr 745, y que sirva como control 

positivo. Efectivamente se observó que el mentol adopta una posición cercana a la Tyr 745, dirigiendo su grupo 

hidroxilo hacia el del aminoácido tirosina, posibilitando la formación de un puente de hidrógeno entre ambos, 

tal y como se muestra en la Figura 4. La energía de unión del mentol en este caso es 5.870x10
-6

 kcal/mol y 

ayudará a determinar si las interacciones de los compuestos estudiados con el canal son más propensas de 

ocurrir o no. 
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Figura 4. Ilustración del resultado del cribado virtual local, donde el mentol se posiciona cerca de la Tyr 745 posibilitando 
la formación de un puente de hidrógeno entre los dos grupos hidroxilo que aparecen en rojo.  

En las siguientes imágenes se observa la interacción de los distintos ligandos con varias partes del 

canal TRPM8 en estado cerrado y abierto. Las partes del receptor señaladas en amarillo representan a los 

residuos que forman parte del sitio de unión del mentol, mientras que en verde los de la icilina. En rojo se 

muestran los residuos que pertenecen a los giros extracelulares y que están en contacto con el ligando. No en 

todas las imágenes aparecen etiquetados la totalidad de residuos con los que contacta el ligando, con el fin de 

facilitar la visualización, aunque sí aparecen en las tablas correspondientes.  

4-acetoxyDMT 

 

Figura 5. Interacciones de los clusters de 4-acetoxyDMT con TRPM8 en estado cerrado (a-mentol, b-bucles extracelulares, 
c-poro y e-buecles extracelulares) y abierto (a, d-mentol y e). 

 

Tabla 4. Resume las características más destacadas de los sitios de unión representados en la Figura 5 para el 4-
acetoxyDMT. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
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interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (7.791-7.236), estado abierto (8.195-6.800). Se recuerda que la energía de unión del mentol es de 5.870 
kcal/mol. 

Hay que tener en cuenta que la falta de información bibliográfica y experimental relacionada con este 

ligando limita la comprobación de la veracidad de los resultados obtenidos (Figura 5 y Tabla 4). Éstos indican 

que existe la posibilidad de interacción con residuos pertenecientes tanto al sitio de unión del mentol como de 

la icilina. En cuanto al sitio del mentol, los residuos que aparecen implicados en la mayoría de uniones son 

Leu750 y Tyr1005, mientras que en el caso de la icilina es Thr803. Por otra parte, destaca el hecho de que 4-

acetoxyDMT es capaz de unirse a las cuatro subunidades del canal a la vez, posicionándose en el centro del 

poro y obstruyéndolo. Por último, 4-acetoxyDMT se une a diversos residuos de los giros extracelulares uno de 

los cuales es una de las cisteínas implicadas en la formación del puente disulfuro, Cys940. Sin embargo y a 

causa del desconocimiento de la función del resto de residuos, sobre la configuración del canal, unido a la falta 

de información experimental donde se haya demostrado la unión de algún ligando a dicha parte del canal, 

solamente se podría especular acerca de la función de los compuestos que se unan a ellos. Los sitios de unión 

representados anteriormente presentan en todos los casos energías de unión mayores que la del mentol. 

5-benciloxigramina  

 

Figura 6. Interacciones de los clusters de 5-benciloxigramina con TRPM8 en estado cerrado (a-mentol, b-icilina y c-bucles 
extracelulares) y abierto (a, b y d-mentol). 

 

Tabla 5. Resume las características más destacadas de los sitios de unión representados en la Figura 6 para el 5-
benciloxigramina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (8.987-8.524), estado abierto (10.136-8.926). Se recuerda que la energía de unión del mentol es de 5.870 
kcal/mol. 
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Los resultados obtenidos del cribado global (Figura 6 y Tabla 5) 

indican la posibilidad de que el ligando se una a los sitios de unión de la 

icilina (Asn799 y Thr803) y el mentol. El parecido estructural entre la 5-

bencilocigramina y la 5-benciloxitriptamina, que se tratará a continuación, 

(núcleo aromático, grupo amina y benciléter) hace sospechar sobre la 

posibilidad de que 5-benciloxigramina se pueda unir a la Tyr745, aunque 

este residuo no haya interaccionado con el ligando durante el cribado 

global. Por eso se realizó un cribado local que indica que la unión con este 

aminoácido se puede dar con una energía de unión de 5.640 kcal/mol. El 

resultado se puede observar en la Figura 7. La distancia entre el grupo hidro ilo de la  rosina y la amina 

secundaria del ligando es de  .     , suficientemente corta como para que ambos elementos puedan 

interaccionar. Por otra parte parece que el ligando puede interaccionar con varios residuos pertenecientes a los 

giros extracelulares además de la Lys856 que se sospecha de que esté implicada en el sitio de unión del mentol 

(se tratará con mayor detalle en la “Discusión”). Finalmente, los sitios de unión representados anteriormente 

presentan en todos los casos energías de unión mayores que la del mentol. 

5-benciloxitriptamina (5-BT) 

 

Figura 8. Interacciones de los clusters de 5-benciloxitriptamina con TRPM8 en estado cerrado (a-bucles extracelulares, b-
mentol, c-icilina y d-icilina) y abierto (b y c). 

 

Tabla 6. Resume las características más destacadas de los sitios de unión representados en la Figura 8 para el 5-
benciloxitriptamina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (10.011-8.959), estado abierto (10.097-9.442). Se recuerda que la energía de unión del mentol es de 5.870 
kcal/mol. 

En diversos estudios (DeFalco et al., 2010; Tesis doctoral Jan-Albert, 2014) se demuestra que el ligando 

5-benciloxitriptamina (5-BT) actúa como antagonista del canal TRPM8, tanto activado por frío como por 

mentol. En dichos casos se propone una posible unión al sitio del mentol y la icilina, por medio de los residuos 

Figura 7. Resultado del cribado local 
de 5-benciloxigramina. 
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Tyr745 y Asn799, respectivamente. Sin embargo, se demuestra por mutagénesis que solamente Tyr745 

realmente media la interacción entre el ligando y el canal.  

Los resultados de cribado virtual global (Figura 8 y Tabla 6) muestran que puede producirse una 

interacción tanto en el sitio de unión del mentol como de la icilina, a través de distintos residuos. Dichas 

interacciones se producen con ambos estados del canal, el abierto y el cerrado y todas ellas presentan una 

energía de unión mayor que en el caso del mentol. Dadas las evidencias experimentales se decidió realizar un 

cribado local, para comprobar si se produce la interacción del ligando con la Tyr745. La Figura 9 refleja el 

resultado obtenido. A pesar de que la distancia entre la amina secundaria del 

ligando y el hidro ilo de la  rosina sea de  .     , es posible que ambos grupos 

interaccionen, con una energía de unión de 7.260 kcal/mol.  

A pesar de haber obtenido varias posibles interacciones entre el ligando 

y las distintas partes del receptor durante el cribado global, al existir evidencias 

experimentales acerca de que la unión se produce con la Tyr745, los demás 

resultados cobran menor importancia.  

6-hidroximelatonina  

 

 

Figura 10. Interacciones de los clusters de 6-hidroximelatonina con TRPM8 en estado cerrado (a-icilina, b-mentol y c-
bucles extracelulares) y abierto (a, d-mentol y e-bucles extracelulares). 

Figura 9. Resultado del cribado local 
de 5-benciloxitriptamina.  
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Tabla 7. Resume las características más destacadas de los sitios de unión representados en la Figura 10 para el 6-
hidroximelatonina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (8.045-7.479), estado abierto (8.662-8.011). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol.  

El ligando 6-hidroximelatonina tiene un parecido estructural con el 4-acetoxyDMT basado en el grupo 

éter y amino, además del núcleo central aromático. Probablemente este parecido posibilite el hecho de que 

ambos ligandos puedan posicionarse en el poro del canal, uniéndose a sus cuatro subunidades a la vez (imagen 

no presentada, pero información reflejada en los gráficos de barras de la Figura 3). Según los resultados del 

cribado (Figura 10 y Tabla 7), el ligando es capaz de unirse a diversos residuos de los giros extracelulares, entre 

los que destacan las Cys929 y Cys940. También se observa la posibilidad de unión al sitio de la icilina a través 

del residuo Ans799 y Thr803 y el del mentol a través de Phe744, Ala747 y Phe748. Los sitios de unión 

representados anteriormente presentan en todos los casos energías de unión mayores que la del mentol. 

Alfa-metilserotonina y alfa-metilserotonina2  

 

 

Figura 11. Interacciones de los clusters de alfa-metilserotonina (a, b, c y d) y alfa-metilserotonina2 (todos los apartados) 
con TRPM8 en estado cerrado(a-icilina) y abierto (a, b-bucles extracelulares, c-mentol, d-icilina y e-mentol). 
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Tabla 8. Resume las características más destacadas de los sitios de unión representados en la Figura 11 para el alfa-
metilserotonina y alfa-metilserotonina2. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia 
de cada una de las interacciones representadas, a continuación se presenta el rango de energía entre el que están 
comprendidas: Alfa-metilserotonina (Estado cerrado (8.572-8.232), estado abierto (9.128-8.317)) y alfa-metilserotonina2 
(Estado cerrado (8.404-7.575), estado abierto (9.007-7.741)). Las siglas (e.p.) significan “esqueleto peptídico” y 
representan el hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena 
lateral de un aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

Se observa que según los resultados del cribado (Figura 11 y Tabla 8), las dos formas del ligando son 

capaces de unirse al sitio del mentol, la icilina y a varios residuos de los giros extracelulares (con una energía de 

unión mayor que la del mentol), lo que indica una falta de esteroespecificidad por parte de los sitios de unión. 

En este caso llama la atención que las dos formas del ligando se unen sobre todo al canal abierto, mientras que 

con el cerrado interaccionan solamente con Asn799. Ya que se observó un parecido estructural (cadena 

alifática con grupo amino terminal) con otros ligandos como el 5-benciloxigramina y el 5-BT que se unen a la 

Tyr745, se realizó un cribado local para comprobar si el alfa-metilserotonina o el alfa-metilserotonina2 son 

también capaces de hacerlo. En el resultado obtenido, el ligando se posicionaba muy lejos del aminoácido 

tirosina, por lo que no se puede unir a éste (imagen no mostrada). 

AMTB 

 
Figura 12. Interacciones de los clusters de AMTB14 con TRPM8 en estado cerrado (a-mentol y b-poro) y abierto (c-icilina). 

 

Tabla 9. Resume las características más destacadas de los sitios de unión representados en la Figura 12 para el AMTB. En 
el apartado b), las siglas A, B, C y D representan el hecho de que la interacción se produce con el residuo D918 de las 
cuatro subunidades. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
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interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (9.305-8.469) estado abierto (9.601-8.772). Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

Debido al parecido estructural entre el antagonista AMTB y el 5-BT que se 

refleja en que ambos ligandos tienen un benciléter y una amina primaria además de 

un núcleo central aromático, es de esperar que se unan al mismo sitio. De hecho 

este es el único compuesto cuyos resultados de cribado global (Figura 12 y Tabla 9) 

muestran una interacción con la Tyr745, clave para el sitio del mentol. Sin embargo, 

como la distancia entre el compuesto y la cadena lateral de la tirosina parece ser 

bastante grande, se realizó un cribado local para acomodar mejor el ligando. Así se 

puede demostrar una clara interacción con la Tyr745, tal y como se muestra en la 

Figura 13. La distancia entre el grupo hidro ilo de la  rosina y el carbo ilo del ligando es de  .     , lo que 

indica que ambos están suficientemente cerca para interaccionar, presentando una energía de unión de 6.730 

kcal/mol.  

Es posible que AMTB se una al sitio de la icilina dada la proximidad de la cadena lateral de Asn799 y el 

grupo amina del ligando. Finalmente y a pesar de la diferencia estructural existente entre este compuesto, 4-

acetoxyDMT y 6-hidroximelatonina, reflejada en su mayor tamaño, parece ser que AMTB también es capaz de 

posicionarse en el centro del poro. 

Todas las interacciones de este ligando con el canal tienen una mayor energía de unión que la del 

mentol. 

CHEMBL236265 

 

 

Figura 14. Interacciones de los clusters de CHEMBL236265 con TRPM8 en estado cerrado (a-icilina y b-mentol) y abierto 
(a, c-mentol, d-bucles extracelulares y e-bucles extracelulares). 

Figura 13. Resultado del 
cribado local de AMTB. 
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Tabla 10. Resume las características más destacadas de los sitios de unión representados en la Figura 14 para el 
CHEMBL236265. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (8.108-7.650) estado abierto (8.918-7.974). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

Los resultados del cribado (Figura 14 y Tabla 10) muestran que el ligando es capaz de unirse al sitio de 

la icilina a través de Asn799 y otros residuos cercanos a este sitio de unión como W798. Además, se posiciona 

entre las cisteínas 929 y 940. Finalmente también es capaz de unirse a residuos del sitio de unión del mentol. 

Todas las interacciones de este ligando con el canal tienen una mayor energía de unión que la del mentol. 

Melatonina 

 

Figura 15. Interacciones de los clusters de melatonina con TRPM8 en estado cerrado (a-bucles extracelulares, b-mentol y 
c-mentol) y abierto (a, b y d-icilina). 

 

Tabla 11. Resume las características más destacadas de los sitios de unión representados en la Figura 15 para la 
melatonina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (8.884-8.295) estado abierto (10.167-8.633). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

La melatonina tiene un gran parecido estructural con la serotonina, y aunque tiene un tamaño 

ligeramente superior, tiene el mismo núcleo central y una cadena lateral con un grupo amina. Este hecho se 

refleja en que se sintetiza a partir de la serotonina. Dado que la serotonina es incapaz de unirse al sitio del 

mentol (tratada más adelante), es de esperar que con la melatonina ocurriera lo mismo, aunque uno de los 
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resultados anteriores (Figura 15 y Tabla 11) muestre la posibilidad de interaccionar con varios residuos 

pertenecientes a dicho sitio de unión. Por otra parte destaca el residuo Asn799 del sitio de la icilina. Debido a la 

falta de información experimental, es difícil garantizar que esto se produzca. Parece ser capaz también de 

interaccionar con Lys856. Las energías de unión del ligando en el caso de todas las interacciones anteriores 

resultan ser mayores que la de referencia del mentol. 

N-acetilhidroxitriptamina 

 

Figura 16. Interacciones de los clusters de N-acetilhidroxitriptamina con TRPM8 en estado cerrado (a-icilina, b-icilina, c-
bucles extracelulares y d-mentol) y abierto(a, b, c, e-mentol, f-bucles extracelulares y g-bucles extracelulares). 

 

Tabla 12. Resume las características más destacadas de los sitios de unión representados en la Figura 16 para la N-
acetilhidroxitriptamina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de 
las interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (9.170-8.268) estado abierto (9.971-8.786). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

La N-acetilhidroxitriptamina tiene una estructura química muy parecida a la serotonina, 

diferenciándose solamente por un grupo acetilo presente en la cadena alifática que en el caso de la serotonina 

tiene un grupo amino terminal. Parece que el ligando es capaz de posicionarse entre los residuos de cisteína de 

los giros extracelulares, aunque en este caso, la interacción con éstos es sobre todo a través de su esqueleto 

peptídico. Además, puede unirse al residuo Asp920 que se cree relevante para el mantenimiento de la 

estabilidad de los estados del canal, y se encuentra en los giros extracelulares (B. Nilius et al., 2005). 
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Finalmente, es capaz de unirse al sitio del mentol y la icilina a través de diversos residuos (Figura 16 y Tabla 12), 

presentando energías de unión mayores que las del mentol.  

N-metilserotonina 

 

Figura 17. Interacciones de los clusters de N-metilserotonina con TRPM8 en estado cerrado (a-icilina, b-icilina y c-mentol) 
y abierto (b, c, d-bucles extracelulares, e-mentol, f-bucles extracelulares y g-bucles extracelulares). 

 

Tabla 13. Resume las características más destacadas de los sitios de unión representados en la Figura 17 para la N-
metilserotonina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (7.972-7.244) estado abierto (8.394-7.573). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

La N-metilserotonina se diferencia de la serotonina en un grupo metilo unido al amino terminal de la 

cadena alifática de la serotonina, lo cual transforma la amina de primaria a secundaria. Sin embargo, este es un 

cambio muy pequeño y es de esperar que este ligando se comporte de igual forma que la serotonina. De hecho 

en los resultados (Figura 17 y Tabla 13) se destacan varios residuos del sitio de unión de la icilina, en vez del 

sitio del mentol. También, al igual que en el caso de la serotonina, se observa que el ligando se posiciona en los 

giros extracelulares, entre los residuos de cisteína y el residuo Asp920. Asimismo las energías de unión en todas 

las interacciones son mayores que la del mentol. 
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Serotonina 

 

Figura 18. Interacciones de los clusters de serotonina con TRPM8 en estado cerrado (a-icilina) y abierto (a, b-bucles 
extracelulares, c-mentol y d-bucles extracelulares). 

 

Tabla 14. Resume las características más destacadas de los sitios de unión representados en la Figura 18 para la 
serotonina. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (7.800-7.492) estado abierto (8.421-7.458). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

Debido a que 5-BT actúa como agonista para el receptor de la serotonina, es de esperar por tanto que 

la serotonina tenga algún efecto sobre el canal TRPM8. Sin embargo, tal y como se muestra en el trabajo de 

DeFalco et al.,2010, esto no se observa. De hecho, los resultados del cribado global (Figura 18 y Tabla 14) 

muestran que existe interacción solamente con el residuo Lys856 de los pertenecientes al sitio de unión del 

mentol. Sin embargo, la serotonina sí podría unirse a Asn799. 

Por otra parte se observa que la serotonina es capaz de interaccionar con residuos posicionados en los 

giros extracelulares del canal posicionándose entre dos residuos de cisteína (Cys929 y Cys940). Todas las 

interacciones de este ligando con el canal tienen una mayor energía de unión que la del mentol. 

ST038837 

 

Figura 19. Interacciones de los clusters de ST038837 con TRPM8 en estado cerrado (a- mentol y b-icilina) y abierto (a, b y 
c- mentol). 



Página 35 de 50 
 

 

Tabla 15. Resume las características más destacadas de los sitios de unión representados en la Figura 19 para ST038837. 
Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las interacciones 
representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado cerrado (9.791-
8.999) estado abierto (10.588-9.587). Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

El ligando ST038837 tiene una estructura química bastante parecida al 

5-BT, diferenciándose solamente en la presencia de un metilo unido al núcleo 

central aromático. Es por eso que se realizó un cribado local, para comprobar la 

posible interacción con la Tyr745 del sitio de unión del mentol. El resultado 

obtenido se puede observar en la Figura 20. La distancia e istente entre el grupo 

hidro ilo de la  rosina y la amina secundaria del ligando es de  .     , mientras 

que con la amina primaria es de  .     . A pesar de que no sean distancias 

relativamente cortas y que garanticen la formación de puentes de hidrógeno, es 

posible que dicho puente se forme (presentando una energía de unión de 5.700 kcal/mol), más teniendo en 

cuenta que se trata de un modelo del canal. Por otra parte cabe destacar el resultado de cribado global (Figura 

19 y Tabla 15) que muestra una interacción del ligando con el residuo Lys856 que está involucrado en 

mantener la conformación del canal a través de la interacción con varios residuos pertenecientes al sitio de 

unión del mentol (A. Pedretti et al., 2009). Finalmente, también se debería destacar la interacción repetida con 

el residuo Asn799 del sitio de unión de la icilina. Todas las interacciones anteriores presentan una energía de 

unión mayor que la del mentol. 

SureCN8058324 

 
Figura 21. Interacciones de los clusters de SureCN8058324 con TRPM8 en estado cerrado (a-icilina, b-bucles 
extracelulares y d-mentol) y abierto (a, c-bucles extracelulares y d). 

 

Figura 20. Resultado del cribado 
local de ST038837. 
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Tabla 16. Resume las características más destacadas de los sitios de unión representados en la Figura 21 para 
SureCN8058324. Para obtener una idea mejor de la probabilidad de ocurrencia y/o importancia de cada una de las 
interacciones representadas, a continuación se presenta el rango de energía entre el que están comprendidas: Estado 
cerrado (10.415-9.196) estado abierto (10.914-10.224). Las siglas (e.p.) significan “esqueleto peptídico” y representan el 
hecho de que la interacción con el ligando se produce a través del esqueleto peptídico y no la cadena lateral de un 
aminoácido. Se recuerda que la energía de unión del mentol es de 5.870 kcal/mol. 

Por último, este ligando también tiene un parecido estructural con el 5-

BT, diferenciándose en poseer en vez de una cadena alifática donde se une el 

grupo amino, un ciclobutano al que se une dicho grupo. En este caso también se 

realizó un cribado local, con el mismo objetivo que en los casos anteriores. El 

resultado se observa en la Figura 22. La distancia entre la amina primaria y el 

grupo hidro ilo de la  rosina es de  .     , lo que indica que existe una gran 

probabilidad de que haya interacción entre ambos grupos, con una energía de 

unión de 7.710 kcal/mol. Por otro lado, la interacción con el sitio de la icilina se 

puede producir a través de Asn799 o Thr803. 

5. Discusión 

Los ligandos analizados en el presente trabajo podrían clasificarse en tres grupos principales según su 

parecido en cuanto a la estructura química. En primer lugar destacan los ligandos 5-benciloxigramina, 5-

benciloxitriptamina, AMTB, ST038837 y SureCN8058324, todos ellos caracterizados por poseer un núcleo 

central aromático al que se une un benciléter y una cadena alifática con un grupo amino (excepto en el caso de 

SureCN8058324, donde se trata de un ciclobutano). Parece claro que todos ellos son capaces de unirse a la 

Tyr745 además de interaccionar con varios de los residuos comprendidos entre 742 y 750 del sitio de unión del 

mentol, por medio de contactos apolares. En el modelo de TRPM8 construido a partir del canal Kv1.2 (Malkia A, 

et al., 2009) se especifica que los residuos Tyr745 y Glu802 interaccionan entre sí de forma polar, estabilizando 

el estado cerrado del canal. En este caso el mentol que se une a Tyr745 rompe esta interacción y provoca un 

cambio conformacional que abre el canal. En dicho modelo estos dos aminoácidos están muy cercanos entre sí, 

hecho que no sucede en el modelo construido a partir de TRPV1, por lo que la unión de los ligandos a la Tyr745 

no produciría el mismo efecto. Para ello se ha intentado buscar otro residuo que esté cerca de la Tyr745 y que 

pueda tener alguna función en la estabilización de los estados del canal. De 

entre todos los residuos analizados, el único que parece que podría 

interaccionar con la Tyr745 es la Tyr826 que se encuentra en el giro 

extracelular que conecta S2 y S3. Como se puede observar en la Figura 23, el 

puente de hidrógeno que posiblemente se forme entre estas dos tirosinas 

puede romperse cuando un ligando interaccione con la Tyr745. Debido al 

cambio tan ligero que se produce en la estructura del canal al pasar del 

estado cerrado al abierto es difícil ver diferencias en las posiciones de 

estos dos residuos de tirosina en ambos estados del canal. 

Figura 22. Resultado del cribado 
local de SureCN8058324. 

Figura 23. Posición de Tyr745 y Tyr826. 
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 Hasta el momento, en la bibliografía no se ha especificado una interacción directa de algún ligando 

con Lys856, sin embargo se cree que este residuo tiene un papel importante en el mantenimiento de la 

conformación del canal a través del contacto con Arg842, siendo ambos residuos destacables para el sitio de 

unión del mentol (A. Pedretti et. al, 2009). A pesar de ello, los resultados del cribado virtual indican la 

interacción de varios de estos ligandos con el residuo Lys856, posicionándose entre éste y el residuo Arg842, 

dificultando la interacción entre ambos. Cabe destacar que la unión al residuo Lys856 se da únicamente en el 

caso del canal iónico en estado abierto.  

Por otra parte, los cinco ligandos son capaces de interaccionar con residuos pertenecientes al sitio de 

unión de la icilina, como Asn799, Asp802 y Thr803, tanto en el caso del canal en estado cerrado como abierto. 

Además, y aunque hasta el presente momento no existían evidencias sobre la interacción con el residuo 

Trp798, los resultados obtenidos indican que en un gran número de casos, los ligandos interaccionan con él. Es 

posible que debido a la cercanía entre Asp802 y Trp798 además de los grupos químicos que presentan ambos 

residuos, exista una interacción entre ambos, que de normal estabilice la hélice de la que forman parte. Si un 

ligando se posiciona entre ellos, esta interacción se rompería produciendo una desestabilización. Teniendo en 

cuenta las energías de unión de todos los intentos de cribado de estos ligandos, destaca el hecho que en el 

caso del canal abierto, las interacciones con mayor energía son las que se producen con los residuos del sitio de 

unión de la icilina. En el caso del estado cerrado, las interacciones de mayor energía se producen tanto con 

residuos del sitio de mentol como la icilina. Las interacciones con los giros extracelulares son menos 

energéticas y por tanto tienen menor prioridad de suceder. Entre ellas hay que destacar la que se produce con 

Asp920 que se encuentra en la entrada del poro, y varios residuos adyacentes. Estudios mutacionales revelan 

que la neutralización de este residuo resulta en un canal inactivo, hecho que podría lograrse por los ligandos. 

Además de normal Asp920 interacciona con Arg890 y Arg897 y al posicionarse un ligando entre ellos dicha 

unión podría romperse y conllevar a la obstrucción del poro.  

En segundo lugar, cabría destacar el grupo formado por los ligandos serotonina y sus derivados N-

metilserotonina, N-acetilhidroxitriptamina, alfa-metilserotonina y 4-acetoxyDMT cuyo parecido no es tan alto 

pero aun así comparte el núcleo aromático y la cadena alifática del resto de compuestos del grupo. A pesar de 

que los resultados del cribado muestran que estos ligandos son capaces de unirse a residuos que forman parte 

del sitio de unión del mentol, debido a que ya ha sido determinado en varios trabajos que la serotonina es 

incapaz de unirse a la Tyr745, estos se despreciarán. Además se realizó un cribado local en el sitio del mentol 

para comprobar que efectivamente no hay interacción con la Tyr745. A pesar de que se obtuvo un cluster que 

se posiciona cerca de este residuo, la energía de unión que presentaba era la más baja. Por otra parte, en un 

gran número de ocasiones, estos ligandos interaccionan con Asn799 y otros residuos del sitio de unión de la 

icilina, estando el canal en estado abierto y cerrado. Aun así, lo que más llama la atención de este grupo, es la 

capacidad de los ligandos de posicionarse en los giros extracelulares, entre los residuos de cisteína 929 y 940 

que forman el puente disulfuro. Además, esta interacción se produce únicamente con el canal en estado 

abierto, por lo que si se produce un cambio conformación, el canal podría quedar bloqueado o inactivo. De 

entre todos los clusters formados por estos ligandos, para el canal abierto y que indican una posible unión con 

alguna de las partes consideradas como primordiales del canal (sitio del mentol, la icilina y los giros 



Página 38 de 50 
 

extracelulares), el 49.33% muestran unión a Cys929 y Cys940, frente al 0% en el caso del canal cerrado. Todos 

los ligandos de este grupo presentan la energía de unión más alta cuando interaccionan con residuos del sitio 

de unión de la icilina, en el caso del canal en estado cerrado. Por otra parte, con el canal abierto, las 

interacciones de más energía se producen con los giros extracelulares, en concreto con el residuo Asp920 u 

otros adyacentes. Por último, cabe decir que la totalidad de este grupo interacciona con Lys856 solamente en 

el caso del canal abierto.  

Finalmente el tercer grupo compuesto por la melatonina, CHEMBL236265 y 6-hidroximelatonina 

parece ser capaz de interaccionar con residuos del sitio del mentol, la icilina y los giros extracelulares, 

destacando en este último caso Cys929 y Cys940 y el Asp920. Viendo las energías de unión de cada ligando, no 

se observa ningún sitio de unión primordial para los dos estados del canal.  

Los ligandos del grupo de 5-BT parecen ser los únicos suficientemente grandes como para 

interaccionar con la Tyr745 y algunos de los residuos 742-750, por medio de interacciones hidrofóbicas. 

Además son los que mejor se adaptan al espacio que queda entre las hélices S2 (sitio del mentol) y S3 (sitio de 

la icilina), pudiendo contactar a la vez con residuos de ambos sitios de unión. En este caso, las interacciones 

hidrofóbicas se forman con los residuos Phe744, Ala747 y Phe748 sobre todo, quedando la cadena alifática con 

el grupo amino dirigido hacia los residuos polares Asp802 y Asn799. Estas interacciones se observan en el caso 

de otros ligandos pero con energías de unión menores, lo cual puede deberse al tamaño más reducido del resto 

de ligandos que limita el contacto con los aminoácidos más importantes. Los compuestos del grupo de la 

serotonina, al presentar menor tamaño se posicionan la mayoría de veces cerca de Asn799 interaccionando 

solo con este residuo. En el caso de los giros extracelulares, en concreto los residuos cercanos a Asp920, 

parecen ser preferidos por ligandos como la serotonina. Esto posiblemente se deba a que los residuos de estas 

posiciones son polares y algunos de ellos presentan carga. La serotonina y sus derivados son los únicos que 

presentan un grupo hidroxilo en su estructura química, el cual junto con el grupo amino es capaz de formar 

fácilmente puentes de hidrógeno. El resto de ligandos suelen presentar un grupo éter, el cual es incapaz de 

compartir hidrógenos y por tanto no puede formar puentes de hidrógeno. En el caso de las interacciones con 

los giros extracelulares en la zona donde están Cys929 y Cys940 hay una gran cantidad de residuos polares, 

algunos de ellos cargados. Además en esta región parece que las 

distintas subunidades se estabilizan por medio de la formación de 

puentes de hidrógeno entre residuos que se encuentran enfrentados 

y que tienen grupos electronegativos. Parece ser que los ligandos que 

más tienden a unirse a esta parte de los giros son aquellos que tengan 

un tamaño mediano-reducido y que presentan grupos hidroxilo y 

amino en su estructura. En la Figura 24 se pueden observar los 

residuos enfrentados que posiblemente ayuden a estabilizar las 

subunidades y cómo la cercanía con el ligando podría interferir en esa estabilización.  

El residuo Lys856 importante para el sitio del mentol parece ser capaz de interaccionar con un gran 

número de ligandos. Sin embargo, en la zona donde se encuentra, que corresponde al linker S4-S5, se observa 

un espacio vacío donde se podría posicionar cualquiera de los compuestos aquí estudiados. Este hecho junto 

Figura 24. Estabilización de las subunidades 
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con las bajas energías de unión correspondientes a la interacción con este residuo hace sospechar que se trata 

de un falso positivo. A pesar de que dicha interacción pueda darse en algún caso concreto se necesitaría un 

estudio más profundo.  

Finalmente, comparando las energías de unión de todos los ligandos en las diversas interacciones con 

alguno de los estados del canal se observa que casi la totalidad de ellas son mayores que la energía de unión 

del mentol que se ha tenido como referencia. Esto indica que en teoría casi cualquiera de las interacciones 

estudiadas tiene mayor probabilidad de suceder que la interacción con el mentol.  

6. Conclusiones y proyección futura 

En primer lugar, no hay que olvidar que el cribado virtual es una herramienta como muchas otras, que 

nos ayuda en el estudio y búsqueda de nuevos moduladores, sin embargo no es sustitutiva de las técnicas de 

laboratorio húmedo e incluso a veces pueden existir discrepancias con ellas, sobre todo a la hora de trabajar 

con modelos de proteínas y no estructuras reales como es el caso.  

Los resultados obtenidos indican que existen preferencias de algunos tipos de ligando por un sitio de 

unión de entre los considerados en este trabajo, en concreto, el del mentol, la icilina y los giros extracelulares. 

Aunque no existan pruebas experimentales y/o bibliográficas hasta el momento, parece factible el hecho de 

que algunos compuestos puedan interaccionar con residuos de los giros extracelulares tal y como se 

sospechaba. Sin embargo, este es solo un primer paso en el estudio de gran parte de dichos compuestos, por lo 

que haría falta profundizar más en él y entender los mecanismos a través de los cuales se podría modular el 

canal TRPM8. Una vez que existen evidencias de la interacción de los ligandos con diversos sitios del canal, 

habría que estudiar la función que tienen éstos, es decir, si son agonistas o antagonistas a través de estudios de 

electrofisiología, por ejemplo. Habría que observar el comportamiento del canal en presencia de los efectores 

en distintas condiciones de temperatura, concentración de mentol e icilina y voltaje para entender mejor la 

función de cada ligando además de su competitividad por un sitio de unión concreto.  
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Anexos 

Anexo 1.  

Alineamiento entre secuencias proteicas de TRPM8 de rata y TRPM8 en estado abierto. 
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El modelo comprende a los residuos 463 hasta 1116 de la proteína original que tiene un tamaño de 1050 

aminoácidos.  
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Anexo 2.  

Macro “dock_run.mcr” para ejecución de cribado virtual global. 

 



Página 44 de 50 
 

 

 



Página 45 de 50 
 



Página 46 de 50 
 

 

 

 

 

 

 

 

 

 



Página 47 de 50 
 

Anexo 3.  

Script para análisis estadístico. 
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Anexo 4.  

Script para búsqueda de interacciones en zonas de interés ya conocidas.  

 


